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1. ЗАГАЛЬНІ ВІДОМОСТІ 

 

Навчальна дисципліна «Верстка друкованих видань» є вибірковою при 

підготовці бакалаврів за програмою ступеневої вищої освіти професійного 

спрямування за освітньо-професійною програмою «Технології друкованих  

і електронних видань». Курс «Верстка друкованих видань» включає лекційні 

заняття, комп’ютерний практикум, індивідуальні та самостійні заняття. 

Основне призначення дисципліни «Верстка друкованих видань» надати 

студентам комплекс теоретичних знань та практичних умінь по створенню 

друкованих видань. Вивчення дисципліни базується на знаннях одержаних під 

час вивчення дисциплін: «Технології опрацювання інформації» «Теорія кольору», 

а також має зв’язки з іншими навчальними дисциплінами: поліграфічним 

матеріалознавством, технологією формних, друкарських та обробних процесів, 

поліграфічним устаткуванням. 

Під час вивчення дисципліни, навчальним планом передбачено виконання 

комп’ютерного практикуму студентами. В результаті проведення практичних 

робіт студент повинен знати:  

– правила макетування та верстки; 

– структуру друкованих видань; 

– засоби макетування та верстки за допомогою програми QuarkXPress, 

Adobe InDesign; 

– характерні особливості оформлення різних видів друкованих видань; 

– створення інтерактивних електронних видань. 

Знання, отримані студентами в процесі вивчення курсу «Верстка 

друкованих видань», успішно можуть використовуватися при вивченні інших 

спеціальних дисциплін, під час курсового і дипломного проектування, а також  

у подальшій виробничій діяльності на поліграфічному виробництві. 
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2. МЕТА ПРАКТИЧНИХ РОБІТ 

Проведення практичних робіт ставить за мету закріплення та поглиблення 

теоретичних знань, набуття практичних навичок макетування та верстки видань 

різної складності та призначення. Характер практичних робіт, їх зміст та 

методика проведення передбачають пізнання, осмислення та практичне 

засвоєння студентами способів макетування складових елементів видань,  

а також особливостей верстки різних видів видань. 

Набуті знання і навички при виконанні практичних робіт сприяють 

розширенню технічної ерудиції, удосконалюють професійні навички студентів при 

виконанні додрукарської підготовки видань. 

 

3. КРИТЕРІЇ ОЦІНКИ ВИКОНАННЯ ПРАКТИЧНИХ РОБІТ 

Оцінка за виконання практичної роботи враховує відповідність виконаної 

роботи сутності завдання, повноту виконання, обсяг і рівень використаних 

теоретичних і практичних знань, наявність елементів творчого, продуктивного 

мислення, оригінальність способу вирішення завдання. 

При повному виконанні всіх робіт у визначені терміни студент може 

отримати заохочувальні бали (до 10 балів) додатково до свого рейтингу за 

результатами виконання творчих робіт з дисципліни: оригінальна підготовка та 

звіт практичних робіт, рефератів, які сприяють підвищенню технічної ерудиції.  

За здачу робіт не у визначені терміни бали не нараховуються. 

За використання чужих робіт і завдань, як своїх (плагіат), несвоєчасне 

виконання завдань, студенту бали не нараховуються. 
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ПРАКТИЧНА   РОБОТА   1 

РОЗРОБКА МАКЕТУ ВИДАННЯ 

ІЗ ЗАСТОСУВАННЯМ МОДУЛЬНОЇ СІТКИ 

 

Мета роботи: ознайомлення з системою запуску програми QuarkXPress, 

панелями інструментів, налаштуванням робочого середовища, видами робочих 

панелей та зон. Вивчення принципу роботи кожного інструменту. Опанування 

інструментами навігації в документі, програмі.  

Завдання роботи: практичне застосування засобів макетування для 

створення модульної сітки видання: направляючих, «сторінок-шаблонів».  

Теоретичні відомості. Для створення нового документу обираємо 

команду File→New→Project. Залежно від виду документу у полі Layout Type 

обирається Print (друковане) або Digital (електронне) видання. За необхідності 

змінити формат та орієнтацію — Layout→Layout Properties. Для того щоб 

створити розворот встановлюємо Facing Pages, для електронних видань, як 

правило не використовується. Вільний простір навколо окреслених сторінок  

є монтажним столом, на якому розміщуються будь-які об’єкти, які відображаю-

ться лише на екрані. 

Створення документу для друку Створення електронного документу 

  

 

Інтерфейс програми наведено на рисунку 1. На робочому столі розміщені 

основні палітри QuarkXPress: палітра Tools (F8) — містить всі необхідні для 

роботи інструменти рисування та редагування; палітра Page Layout (F4) — 

використовується для переміщення між сторінками публікації та управління 

шаблонами, додавання/виключення/переміщення сторінок, шляхом кліку ПКМ 
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на необхідній сторінці Insert/Delete/Move/ Section/Go to; палітра Measurements 

(F9) — призначена для форматування тексту та проведення різноманітних дій 

над об’єктами: масштабування, переміщення, обертання та ін.; палітра Style 

Sheets (F11) — застосовується для управління стилями в публікації. Інші 

палітри знаходяться в меню Window. Основні налаштування програми знахо-

дяться в меню Edit→ Preferences (рис. 2): колірного оформлення інтерфейсу; 

параметрів зберігання, тексту, історії та інші. 

 

Рис. 1. Інтерфейс програми 

Загальний вигляд інтерфейсу програми QuarkXPress наведено на рисунку 1, де 

1 — панель меню програми, 2 — панель налаштування параметрів інструментів, 

змінюється залежно від обраного інструменту, 3 — панель інструментів, 4 — 

палітри, які викликаються за необхідності з меню Window.  

 

Рис. 2. Налаштування програми QuarkXPress 
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Для створення модульної сітки використовуються: лінійки, направляючі, 

колонки, базова сітка (меню View). Модульна сітка з певним кроком (модулем), 

однаковим або різним по горизонталі й вертикалі є основою композиції шпальт, 

сторінок і розворотів. Якщо модулі по горизонталі й вертикалі однакові, 

коміркою модульної сітки буде квадрат, якщо різні — прямокутник. Елементи 

шпальти (заголовки, ілюстрації, підписи до них, декоративні елементи, 

колонтитули і т. ін.) розверстуються по комірках сітки. Підбирають сітку, 

виходячи з особливостей  матеріалу видання. Тільки в цьому разі вона може 

дати позитивний результат (чітке структурне розмежування елементів, 

естетично красиве їх розміщення і чітку організацію матеріалу), а не привести 

до механічного компонування.  

Налаштування прив’язки об’єктів до направляючих, розміщення та 

кольору Edit→Preferences→Guides&Grid. Елементи макету, які неодноразово 

повторюються, як правило, розміщують на сторінках-шаблонах (палітра Page 

Layout). Автоматична нумерація сторінок створюється комбінацією клавіш 

Ctrl+3 на сторінках-шаблонах у відповідному місці. Налаштування ліній базової 

сітки, розмірів полів, кількості колонок виконується на сторінках-шаблонах 

палітри Page Layout: Page→Master Guides&Grid. В групі Margin Guides в полях 

Top/Bottom/Left/Right встановлюються розміри полів: верхнього/нижнього/ 

лівого/правого. В групі Column Guides вводяться значення кількості колонок та 

відступу між ними. В полі Content Dimensions відображаються розміри сторінки 

складання. 

 

 

Методика виконання роботи:  

1. Отримати індивідуальне завдання: обрати . 

2. Визначити стандартні формати: видання, сторінки складання та обрати 

величину полів. 

3. На аркушах паперу формату А4 накреслити ескізний розрахунковий  

макет художнього оформлення видання. 

1. Маркер, який вказує на шаблонну сторінку 

2. Перехід на шаблонну сторінку на палітрі Page Layout 
 

Маркер, який вказує на автоматичну 

нумерацію. Встановлюється комбінацією 

клавіш на шаблоні Ctrl+3 
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4. Створити електронну модульну сітку на основі ескізного макету, 

обов’язково застосувати «сторінки-шаблони» для рубрикації, колонтитулів, 

колонцифр, текстових/графічних фреймів, елементів оформлення та ін. 

Зміст і форма звіту:  

1. Виготовлені ескізні розрахункові макети художнього оформлення видання 

на папері формату А4. 

2. Створений цифровий файл. 

Контрольні запитання усного звіту: 

1. Як створити новий документ? 

2. Редагування формату та орієнтації видання? 

3. Як налаштувати направляючі? 

4. Створити розворот видання та проставити нумерацію? 

5. Виконати налаштування одиниць вимірювання? 

6. Редагування розмірів полів та кількості колонок на сторінці складання? 

Перелік літератури: 

1. СОУ 18.1-02477019-14:2015. Видання книжкові. Технічні умови. ― На заміну ГСТУ 

29.5―2001; чинний від 2009—11—01. 

2. Гиленсон П. П. Справочник художественного и технического редакторов / 

П. П. Гиленсон. — М.: Книга, 1988. — 528 с. 

3. Комолова Н. В. Компьютерная верстка и дизайн [Текст] / Н. В. Комолова. — СПб.: 

БХВ-Петербург, 2003. — 512 с. 

 

 

Рис. 3. Приклад розвороту галузево-професійного журналу для виконання роботи 
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а 

 

б 

Рис. 4. Приклад розвороту галузево-професійного журналу для виконання роботи: 

а – шаблонна сторінка; б – зверстанна сторінка 

 

Рис. 5. Приклад виконання ескізного макету 



 

 11 

ПРАКТИЧНА   РОБОТА   2 

РОБОТА З ТЕКСТОВИМ ТА ІЛЮСТРАТИВНИМ МАТЕРІАЛОМ 

 

Мета роботи: вивчення принципів обробки текстового матеріалу, 

принципів форматування тексту. Вивчення прийомів створення, форматування та 

редагування ілюстративного матеріалу. Ознайомитись з графічними, стильовими та 

колірними способами оформлення ілюстративної інформації. 

Завдання роботи: частина 1: створення одно- та багатошпальтної сторінки 

складання, застосувавши шрифтові та колірні виділення тексту; частина 2: 

створення різноманітних графічних фреймів та застосувати до них різних 

способів оформлення. 

Теоретичні відомості. Для набору тексту використовується інструмент 

Text Content Tool, за допомогою якого створюються текстові фрейми, для 

імпорту тексту обираємо File→Import. Автоматичне заповнення текстових 

фреймів встановлюється при створенні документу File→New Project→ Automatic 

Text Box. Для зв’язування текстових фреймів використовується інструмент Text 

Linking Tool, для розірвання — Text Unlinking Tool. Для редагування текстових 

та графічних фреймів використовується палітра Measurements (Window→ 

Measurements), яка змінює свої налаштування, залежно від того, який тип 

фрейму обрано, наведено на рисунку 6. Також налаштування параметрів 

текстового/графічного фрейму дублюється у меню — Item→ Modify. Контент 

фрейму можна змінити через праву клавішу мишки Content: 
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Рис. 6. Палітра Measurements 

Для форматування тексту та абзаців використовується меню Style→ 

Character Attributes/Formats (Paragraph Attributes) або палітра Measurements. Для 

зручності форматування тексту рекомендовано включати режим відображення 

недрукованих символів — View→Invisibles. Для оформлення незначної 

кількості абзаців лінійками можна скористатися Style→Paragraph Attributes→ 

Rules, а для великих об’ємів тексту зручно застосувати палітру стилів Style 

Sheets. Створені таблиці стилів оформлення абзаців та символів можна 

застосовувати в інших публікаціях. Перетворення тексту в об’єкт — Item→ 

Convert Text to Boxes. 

Для роботи та створення графічних об’єктів застосовуються інструменти: 

Picture Content Tool, Rectangle/Oval/Starburst Box Tool, Composition Zones Tool, 

Line Tool, Bezier Pen Tool. Робота з даними інструментами аналогічна 

інструментам векторної графіки (Adobe Illustrator). 
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Налаштування параметрів графічного фрейму — Item→Modify. Для 

трансформації, вирівнювання об’єктів, зміни розмірів, кута повороту, товщини 

та стилю лінії використовуються вкладки палітри Measurements. Створення 

об’єктів неправильної складної форми Item→Merge or Split Paths. Для 

переміщення деякої кількості копій об’єкту на певну 

відстань використовується меню Item→ Step and 

Repeat. Для створення масиву використовується 

Item→ Super Step and Repeat. Масив включає, не 

тільки переміщення, а ще додатково зміну кута 

нахилу, товщини рамки, розмірів, скосу, 

насиченості і вибір відносної точки. 

 

 
4 
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Для встановлення різних типів обтікання 

графічних фреймів, ліній текстом використовується 

Item→ Modify→Runaround. У списку Type доступні 

варіанти обтікання: None — обтікання відсутнє, текст 

розміщується на зображенні; Item — обтікання навколо 

графічного фрейму на відстані, встановленій у полях; 

Auto Image — програма автоматично визначає межі 

зображення, розміщеного в графічному блоці, і виконує 

обтікання навколо них; Embedded Path — обтікання за траєкторією, яка збережена 

разом із зображенням; Alpha Channel — обтікання за формою збереженого альфа-

каналу; Non-White Areas — обтікання усіх частин білого кольору, при активній 

функції Invert білі частини стануть видимими, а текст заповнить всі інші 

фрагменти зображення; Same as Clipping — обтікання за контуром, що 

встановлений у вкладці Clipping; Picture Bounds — обтікання за контуром 

зображення всередині фрейму. Контур обтікання стає доступним для 

редагування при деактивації функції Restrict to Box вкладки Item→Modify→ 

Runaround. Вкладка Item→Modify→ Clipping застосовується для обрізки імпорто-

ваного зображення.  

Додаткові опції налаштування контуру обтікання вкладки Item→ 

→Modify→Runaround: Outset — відступ тексту від границь зображення; 

Noise — опція дозволяє не враховувати випадкові пікселі, які викликають 

нерівномірність та складність контуру обтікання; Smoothness — ступінь 

точності траєкторії обтікання зображення, при малих значеннях текст більш 

точно обтікає зображення, а при великих — контур обтікання нагадує більш 

прості фігури; Threshold — дія опції базується на відсотковому відношенні 

насиченості/кольору та дозволяє встановити, які ділянки зображення будуть 

визначені як чіткі межі об’єктів, тобто колір пікселів світліший за встановлене 

значення буде вилучатися.  Чим вище значення цього параметру, тим більшу 

частину зображення програма сприйматиме за білі ділянки. Invert — текст 

розміщується всередині контуру обтікання; Outside Edges Only — при активації 

опції використовується зовнішня границя зображення в якості контуру 

обтікання. 

Cтворення та редагування кольорів виконується за допомогою палітри 

Window→Colors→New. Для створення пантонного кольору необхідно при 

створені поставити Spot Color. Якщо графічне зображення виступає в якості фону, 

як правило, для нього встановлюється певний відсоток прозорості на палітрі 
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Colors→Picture Color→Opacity. Градієнт створюється/редагується на палітрі 

Gradients, змінюючи вид градієнту, колір, розміщення та кількість кольорів. 

  

Cтворення/редагування власного стилю ліній виконується за допомогою 

Edit→Dashes&Stripes→New/Edit.  

   

Методика виконання роботи. Частина 1. Виконати оформлення тексту 

засобами програми QuarkXPress відповідно до отриманого індивідуального 

завдання (рис. 7): 

1. Відтворити різні види накреслення. 

2. Провести форматування текстового блоку: 

2.1. створити відбивки, виключки, вирівнювання по базовій лінії; 

2.2. застосувати лінійки для відбивок; 

2.3. створити перетікання тексту, обертання; 

2.4. створити різні стилі окантовки текстового фрейму; 

2.5. створити перетікання/обтікання тексту; заливка градієнтом. 

3. Вставити графічне зображення в текст, застосувати тіні, відтворити 

текст вивороткою, розмістити текст на кривій. 

4. Створити буквицю та маркований список. 

5. Приклад виконання першої частини роботи наведено на рисунку 7. 
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Методика виконання роботи. Частина 2. Виконати оформлення 

графічних об’єктів засобами програми QuarkXPress відповідно до отриманого 

індивідуального завдання (рис. 8): 

1. Створити та виконати трансформацію графічних фреймів. 

2. Застосувати до графічних фреймів: поворот, деформацію, тінь, обведення 

різними стилями ліній, різні стилі оформлення кутів, заливку різними типами 

градієнтів. 

3. Виконати обтікання текстом: геометричних фігур, ліній, графічних 

зображень. 

4. Виконати редагування контуру графічного фрейму при обтіканні. 

5. Створити власний стиль суцільної та шрихової ліній. 

6. Створити графічну буквицю. 

7. Створити підпис та розмістити його на кольоровому тлі.  

8. Створити пантонні кольори з чотирьох, шести фарб. 

9. Використати графічне зображення в якості фону. 

10. Приклад виконання роботи наведено на рисунку 8. 

Зміст і форма звіту:  

1. Створений цифровий файл. 

Контрольні запитання усного звіту: 
1. Як імпортувати текст у програму верстки? 

2. Як створити зв’язані текстові фрейми? 

3. Як виконується форматування тексту, розміщення його на лініях довільної форми? 

4. Розмістити зображення у тексті? 

5. Як виконати редагування буквиці та маркованого списку?  

6. Виконати редагування контуру обтікання зображення? 

7. Створення та редагування градієнту? 

8. Як створити графічний фрейм неправильної форми? 

9. Особливості створення власного стилю штрихових та суцільних ліній? 

10. Як надати зображенню певного відсотку прозорості? 

 

Перелік літератури: 
1. Глушаков С. В., Кнабе Г. А. Компьютерная верстка: Учебный курс. [Текст] / С. В. 

Глушаков, Г. А. Кнабе. — Харьков: Фолио, 2002. — 485 с.  

2. Паркер Р. Как сделать красиво на бумаге, 2-е издание  — Пер. с англ. / Р. Паркер. — 

СПб.: Символ-Плюс, 2008. — 384 с.   

3.  Ярема С. М. Видавничі поліграфічні технології та обладнання / С. М. Ярема. — Київ: 

Університет «Україна», 2003. — 320 с. 
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Рис. 7. Приклад виконання першої частини роботи 2 



 

 18 

 

Рис. 8. Приклад виконання другої частини роботи 2
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ПРАКТИЧНА   РОБОТА   3 

СТВОРЕННЯ ТАБЛИЦЬ, ВИСНОВКІВ 

 

Мета роботи: опанування принципами створення таблиць у програмі  

QuarkXPress. Навчитися застосовувати графічне, стильове та колірне оформлення 

таблиць.  

Завдання роботи: створити та виконати форматування таблиць. 

Теоретичні відомості. Для створення таблиць використовується 

інструмент Table Tool, редагування таблиць — натиснути праву клавішу миші, 

при виділеній таблиці, та обрати Table. При створенні таблиці зазначається тип 

комірок в палітрі Table Properties: Text/Picture Cells. Є можливість вставлення 

таблиці із зовнішнього джерела, для цього необхідно в палітрі Table Properties 

включити Link to External Data та обрати необхідний файл, при цьому також 

налаштовуються параметри експорту на палітрі Table Link. Вид комірок 

змінюється: Item→Content→Text/Picture. Вибір окремої лінійки таблиці 

виконується за допомогою інструмента Text Tool. Якщо необхідно зберегти 

загальний розмір таблиці при зміні розмірів/додаванні/видаленні рядків/стовп-

чиків активуємо опцію Modify→Table→ Maintain Table Geometry. 

  

 

Текст розбитий знаками табуляції можна перетворити на таблицю Table→ 

Convert Text to Table. Обернене перетворення таблиці в текст: Table→Convert 

Table to Text, при цьому текст таблиці розміщується в автоматично створеному 

текстовому блоці. Для конвертування таблиці в групу блоків необхідно 

виконати команду Table→Convert Table→To Group, при цьому текст таблиці 

розміщується в окремих блоках, які відповідають коміркам. Для розгрупування 

блоків виконуємо команду Item→Ungroup. 
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Методика виконання роботи. На основі отриманого зразка табличного 

матеріалу студент створює таблицю засобами програми QuarkXPress, рис. 9: 

1. Створити таблицю. 

2. Застосувати до складових таблиці:  

 різний колір, товщину, тип оформлення лінії для вертикальних та 

горизонтальних лінійок таблиці; 

 заливання комірок таблиці кольором, градієнтом; 

 об’єднання рядків, стовпчиків. 

3. Виконати форматування тексту в комірках таблиці: 

 розмістити текст по центру, по верхній/нижній лінії; 

 встановити відступи від лінійок в комірках (однакові, різні). 

Зміст і форма звіту:  

1. Створений цифровий файл. 

Контрольні запитання усного звіту: 
1. Як виконати додавання/видалення/об’єднання рядків/стовпчиків у таблицях? 

2. Як зафарбувати комірку таблиці кольором/градієнтом? 

3. Як виконати оформлення ліній у таблиці: кольором, товщиною тощо? 

4. Форматування тексту у таблиці: вирівнювання по горизонталі/ вертикалі, відступи в 

комірках, форматування? 

5. Як забезпечити збереження розмірів таблиці? 

6. Як перетворити таблицю у текст, і навпаки? 

Перелік літератури: 
1. Паркер Р. Как сделать красиво на бумаге, 2-е издание  — Пер. с англ. / Р. Паркер. — 

СПб.: Символ-Плюс, 2008. — 384 с.   

2. Глушаков С. В., Кнабе Г. А. Компьютерная верстка: Учебный курс. [Текст] / С. В. Глушаков, Г. 

А. Кнабе. — Харьков: Фолио, 2002. — 485 с.  

3. Комолова Н. В. Компьютерная верстка и дизайн [Текст] / Н. В. Комолова. — СПб.: 

БХВ-Петербург, 2003. — 512 с. 
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Рис. 9. Приклад виконання роботи 3 (Початок) 

 

Рис. 9. Приклад виконання роботи 3 (Продовження)
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Рис. 9. Приклад виконання роботи 3 (Закінчення) 
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ПРАКТИЧНА   РОБОТА   4 

СТВОРЕННЯ ЦИФРОВОГО ОРИГІНАЛ-МАКЕТУ 

КНИЖКОВОГО ВИДАННЯ 

 

Мета роботи: навчитися створювати оригінал-макет книжкового видання. 

Здійснити обробку та форматування тексту, графічного, табличного матеріалу 

відповідно до вимог книжкової верстки. 

Завдання роботи: відповідно до варіанту виконати верстку книжкового 

видання. 

Теоретичні відомості. Зміна формату, орієнтації сторінки, виконується: 

Layout→Layout Properties. Розмір полів змінюється лише на шаблонних 

сторінках. Якщо необхідно встановити нумерацію сторінок з певної сторінки 

виконуємо команду Page→Section→Number, у разі застосування префіксу до 

номеру сторінку, його вводять у поле Page→ Section→Page Number→Prefix. 

Для того, щоб уникнути завислих рядків доступні 

такі налаштування: Style→Formats→ Keep Lines 

Together — заборона висячих рядків; All lines in —

 не розривати рядки всього абзацу; Start/End —

 залишати знизу сторінки не менше двох рядків 

(кількість змінна) та переносити на наступну 

сторінку не менше двох рядків (кількість змінна); 

Keep with Next — не відривати один абзац від 

іншого, наприклад, заголовок від основного тексту; 

Lock to Baseline Grid — прив’язати рядки абзацу до 

сітки базових ліній.  

Запорукою якісно зверстаного видання є при-

ведення рядків, що реалізується за допомогою 

базової лінії — Baseline. Сітка базових ліній — 

регулярна сукупність горизонтальних ліній, яка 

відображається на сторінках шаблонів і публікацій, 

розміщуючись з верхнього поля кожної сторінки, 

слугує для вирівнювання тексту. Розрізняють сітки 

шаблонних сторінок та сітки текстових блоків.  

Для налаштування сітки шаблонних сторінок, 

необхідно на шаблонній сторінці викликати 
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Page→Master GuidesGrid→Text Settings. Налаштування сітки текстового 

блоку викликається при натисненні правою кнопкою миші на текстовому блоці: 

Grid Settings→Text Settings. Font Size — розмір для визначення висоти кожного 

рядка сітки. Font Scaling — налаштування висоти кожного рядку сітки на основі 

кеглю шрифта (у %). Значення Line Spacing та Leading визначають відстань між 

рядками та інтерліньяж відповідно. Character Spacing — інтервал між 

символами. Baseline Position — вибір положення базової лінії в сітці: Place at % 

from the — встановлюється відсоток зміщення від верхньої, середньої, базової 

або нижньої ліній; Read from font — положення базової лінії в кожному рядку 

розраховується на основі базової лінії вибраного шрифту. Offset — зміщення 

розташування першого рядку сітки (на сторінці або в текстовому блоці). Cells 

per line та Lines within box — кількість знаків та рядків на сторінці складання 

(текстовому блоці), Adjust дає можливість редагувати їх кількість. Preview — 

активує режим перегляду налаштування сітки базових ліній. Також можна 

завантажити раніше створені сітки базових ліній — Load Settings. 

Особливостями книжково-журнальної верстки є обов’язкове формування 

змісту, алфавітних покажчиків, списків ілюстрацій тощо. Створення, так званих, 

таблиць списків реалізується за рахунок застосування стилів до необхідних 

структурних елементів. Стиль оформлення створюється на палітрі Style Sheets: 

New Character/Paragraph style. 

Для формування змісту необхідно виконати команду Edit→Lists→New для 

доступу до вікна Edit List (рис. 10). 

Щоб задати текст, який буде у змісті, треба вибрати потрібний стиль  

у лівій частині і перенести його у праву за допомогою стрілки в середній 

частині вікна. У полі Styles in List містяться додаткові параметри: Name — назва 

 

Рис. 10.  Діалогове вікно Edit List 
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стилю, Level — рівень пріоритету стилю, Numbering — вибір варіанту номерів 

розташування сторінок відносно списку: Text only/ Text…Page#/ Page…Text 

(лише текст/текст…номер№/номер№…текст), Formats As — вибір спеціального 

стилю для форматування списку. Для автоматичного створення списку за 

алфавітом необхідно активувати Alphabetical*. Після налаштування всіх 

параметрів, необхідно зберегти список натиснувши Ok. Новий список 

додається до палітри Lists (Списки). 

Для відображення сформованого списку необхідно викликати палітру Lists 

з меню Window та обрати потрібний список з меню List Name, всі елементи 

списку будуть відображені у вікні перегляду. Для швидкого переходу до 

певного елементу списку треба двічі клацнути на ньому у вікні Lists. Для того, 

щоб розмістити список/зміст у документі необхідно створити текстовий блок  

і натиснути кнопку Build (Створити) (рис. 11).  

 

Рис. 11. Палітра Lists та сформований зміст 

Повну інформацію про всі зображення та шрифти, які задіяні у публікації 

можна отримати за командою Utilities→Usage. У вкладці Picture доступні поля: 

Print (дозволяє/забороняє друк зображень), Status (відображає стан зображень: 

Missing/ Modified/Ok), Type (тип файлу). 

У випадку відсутності/модифікації файлу (Missing/Modified) його 

необхідно підставити/ обновити List Picture/Update. Вкладка More info дозволяє 

отримати інформацію про зображення/ шрифти: тип, місце розміщення тощо. 

 

                                                 
* Функція коректно працює лише з англійською мовою 
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Вставка виноски виконується у меню StyleInsert Footnote. Редагування/ 

налаштування оформлення виноски та лінійки виноски виконується у меню 

EditFootnote Styles NewFootnote/Endnote Style або Footnote Separator 

Style. Для створення стилів оформлення виноски призначена палітра Footnote 

Styles меню Window.  

  

  

 

Програма верстки дозволяє змінювати зовнішній вигляд зображення за 

допомогою таких візуальних ефектів, як тонування зображення, корекція 

кольору, яскравості/контрасту тощо. Засоби роботи з зображенням розміщені  

в меню Style→Image Editing або на палітрі Image Editing меню Window. 

Функція Image Editing включає корекцію (Adjustments) та фільтри (Filters), 

аналогічні Photoshop-у, та дозволяє виконувати корекцію зображень безпо-

середньо у макеті верстки без необхідності переключатися до програм обробки 

зображень. Зміни, виконані за допомогою функції Image Editing, не впливають 

на вихідні файли зображень. 

Всі зміни внесені до зображення (масштабування/корекція колірного змісту/ 

ефекти) можуть бути збережені у вихідному або у новому файлі зображення.  
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Для збереження «зміненого» зображення необхідно 

вибрати File→ Export Picture→Selected Picture/All Pictures 

in Layout→Picture Export Options.  

При експорті зображення можна вказати, які зміни 

необхідно зберегти для вибраного зображення, тип файлу 

та колірний простір. Крім того, можна обрати заміну вихід-

ного або створення нового файлу. Необхідно активувати 

Overwrite Original для заміни вихідного файлу, або Link to 

New Picture для збереження нового файлу та заміни 

посилання на вихідний файл.  

Для коректної підготовки цифрового оригінал-макету необхідно виконати 

File→Collect for Output. При цьому програма верстки здійснює аналіз, 

перевірку та збір використаних шрифтів, зображень у макеті. 

У деяких виданнях використовують рисовані, декоровані або графічно 

оформлені ініціали — буквиці. Їх застосовують для виділення початку частин 

тексту, на які ділиться твір: розділів, глав, параграфів. Буквиця викори-

стовується для привернення уваги читача до початку певного блоку тексту. 

Існують спеціально розроблені шрифти початкових букв абзаців, але практично 

будь-яку велику літеру можна використовувати в якості буквиці. З положення 

щодо абзацу розрізняють буквиці: винесені вгору (рис. 12, б), утоплені (рис. 12, 

а, г), вільні або висячі (рис. 12, в). 

Лівий край буквиці має бути вирівняний по лівому краю текстового блоку 

у випадках — рис. 12, а–б, або може бути дещо зсунутий вліво – рис. 12, г, 

якщо літери мають звисаючі елементи (як у літер Т, Ф). Вільні або висячі 

буквиці взагалі не вбудовуються у формат рядку, а розміщуються окремо зліва 

від тексту. Текст першого рядку набирають впритул до буквиці, інші рядки 

відбивають від неї на напівкегельну. 

Для виділення заголовків використовують різні композиційні прийоми їх 

розміщення (рис. 13). Заголовки, які набираються окремими рядками, 

найчастіше виключають в новий рядок і розміщують посередині сторінки 

складання або зміщують до лівого краю набору — це так звані флагові 

заголовки. Їх відбивають від основного тексту проміжками. 
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Рис. 12. Варіанти розміщення буквиць у тексті: 

а, г – утоплена; б – винесена вгору; в – вільна або висяча 

 

При розробці оформлення колонтитулів та колонцифр слід звернути увагу 

на те, що колонцифри всіх видів та колонтитули не ставлять на: 

– титульних сторінках видання (авантитулі, контртитулі, фронтисписі, 

титулі, шмуцтитулі, звороті титула); 

– на пустих полосах (зворот титула, шмуцтитула, сторінках «для записів»); 

– на сторінках з вихідними даними; 

– на сторінках, які містять полосні ілюстрації (як виняток, в науково-

технічних виданнях, на сторінках зі схемами/графіками тощо, колонцифри 

проставляють). 

Всі зазначені вище сторінки входять у загальну кількість сторінок видання. 

Не ставлять колонцифри на вклейках, які не входять в загальну кількість 

сторінок видання. 

Верхні колонцифри (з колонтитулами, колонлінійками або без них) не 

ставлять на всіх початкових сторінках розділів. Нижні колонцифри не 

розміщують на кінцевих сторінках. 
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Рис. 13. Варіанти розміщення заголовків у тексті: 

а, – простий, вирівнювання по центру; б – простий врозріз, вирівнювання по центру;  

в – заголовок в оборку (кватирка); г – заголовок на полях (ліхтарик або маргіналія) 

Методика виконання роботи. За даними варіанту студент створює 

цифровий оригінал-макет книжкового видання засобами програми QuarkXPress. 

1. Розрахувати розмір видання після обрізу, визначити розміри сторінки 

складання та полів, відповідно до завдання. 

2. Розробити шаблони та виконати верстку основних складових книжкового 

видання: подвійний титульний аркуш, який містить чотири сторінки (авантитул, 

контртитул, титул, зворот титулу); шмуцтитул, початкову, кінцеву та типову 

сторінки складання. Загалом має бути 16 сторінок. 

3. Обов’язково створити заголовки трьох рівнів та на їх основі автома-

тично згенерувати зміст. 

4. Для оформлення колонцифр застосувати префікси або графічні 

елементи. 
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Верстку видання виконати, відповідно до правил заверстування певного 

виду видання, враховуючи кількість ілюстрацій та наявність додаткових 

елементів оформлення. За згодою викладача, студент може використати для 

верстки додаткові елементи оформлення видання. Складові елементи оформ-

лення видання, зазначені у таблиці, повинні бути обов’язково використані. 

Верстка основного тексту виконується в одну шпальту (колонку).  

Таблиця 1 — Варіанти завдань для виконання практичної роботи 4 

№ 

варіан-

ту 

Назва видання Формат 

Варіант 

оформ-

лення 

Кількість 

ілюст-

рацій 

Додаткові 

елементи 

1 2 3 4 5 6 

1 Збірник наукових праць 70108/16 2 3 

колонтитул3.1, 

таблиця, 

заголовок1.1 

2 Збірник віршів 70100/32 3 7 

декоративні 

елементи, 

епіграф 

3 Літературно-художне видання 84108/16 3 5 

колонтитул3.2, 

заставка, 

виноска 

4 
Видання для дітей середнього 

шкільного віку 
6090/16 2 5 

буквиця2.1, 

примітка у тексті, 

колонтитул3.1 

5 
Збірник драматургійних 

творів 
70100/16 2 4 

колонтитул3.2, 

епіграф, виноска 

6 
Енциклопедія для дітей 

середнього шкільного віку 
7090/16 2 9 

колонтитул3.2, 

заголовок1.2, 

виноска 

7 
Документально-художнє 

видання 
6084/16 2 5 

цитата, таблиця, 

кінцівка 

8 

Навчальний посібник  

з дисципліни для дітей 

старшого шкільного віку 
84108/32 2 3 

виноска, 

заголовок1.3, 

таблиця 

9 Монографія 84108/16 3 2 
колонтитул, 

цитата, таблиця 

10 
Посібник з дисципліни для 

вищих навчальних закладів 
70108/16 2 2 

колонтитул3.2, 

примітка у тексті, 

заголовок1.1 

11 Збірка віршованих творів 6084/16 3 8 

астеріск, 

виноска, 

колонтитул3.1 

12 

Хрестоматія з української 

літератури для дітей 

середнього шкільного віку 
7090/16 2 3 

початкова 

сторінка зі 

спуском, 

кінцівка,  

цитата 
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Продовження табл. 1 

1 2 3 4 5 6 

13 
Термінологічний словник 

поліграфічної галузі 
6090/16 2 4 

колонтитул3.2, 

епіграф, таблиця 

14 
Практикум з дисципліни для 

вищих навчальних закладів 
70100/16 2 5 

колонтитул3.2, 

примітка, 

заголовок1.3 

15 
Альманах драматургічних 

творів 
70108/16 3 7 

колонтитул3.1, 

початкова 

сторінка без 

спуску з 

буквицею2.3 

16 
Збірник віршів для молодшого 

шкільного віку  
6084/16 3 3 

декоративні 

елементи, 

виноска, 

буквиця2.2 

17 Навчальний посібник 6090/16 1 3 

колонтитул3.2, 

виноска, 

таблиця 

18 

Літературно-художнє видання 

для дітей середнього та 

старшого шкільного віку 
70108/16 2 2 

колонтитул3.1, 

епіграф, 

декоративні 

елементи 

19 Науково-популярне видання 6084/16 2 5 

буквиця2.1, 

таблиця, 

примітка 

20 
Курс лекцій з дисципліни для 

вищих навчальних закладів 
6084/16 1 4 

виноски, 

колонтитул3.2, 

заголовок1.2,  

21 

Літературно-художнє видання 

для дітей молодшого та 

середнього шкільного віку 
6090/8 3 8 

колонтитул3.2, 

заставка, почат-

кова сторінка зі 

спуском 

22 Науково-популярне видання 6084/8 2 7 

декоративні 

елементи, 

цитата, таблиця 

23 Довідник 84108/32 1 3 

колонтитул3.2, 

виноски, 

заголовок1.3 

24 

Науково-популярне видання 

для дітей середнього та 

старшого шкільного віку 
7090/16 2 5 

декоративні 

елементи, 

буквиця2.3, 

виноски 

25 
Антологія української 

драматургії 
6084/16 3 3 

колонтитул3.1, 

епіграф, 

декоративні 

елементи 
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Закінчення табл. 1 

1 2 3 4 5 6 

26 
Збірка драматургійних та 

віршованих творів 
70100/16 3 6 

виноска, 

початкова 

сторінка зі 

спуском, 

заставка 

27 Науково-технічний збірник 70108/16 2 2 

колонтитул3.1, 

таблиця, 

примітка  

у тексті 

28 
Енциклопедія для дітей 

старшого шкільного віку 
70100/16 2 4 

колонтитул3.1, 

виноска, 

заголовок1.2 

29 
Документально-художнє 

видання 
6084/16 3 3 

колонтитул, 

епіграф, 

заголовок1.2,  

30 Науково-художнє видання 7590/16 2 5 

колонтитул3.2, 

декоративні 

елементи, 

таблиця 

31 
Навчальний посібник для 

дистанційного навчання 
6084/16 2 3 

колонтитул3.1, 

таблиця, 

примітка 

32 

Літературно-художне видання 

для молодшого та середнього 

шкільного віку 
70100/16 1 4 

заставка, 

кінцівка, 

початкова 

сторінка зі 

спуском 

33 

Літературно-художне видання 

для середнього та старшого 

шкільного віку 
70100/16 2 5 

декоративні 

елементи, 

виноска, 

буквиця2.3 

34 Науково-популярне видання 84108/16 3 3 

колонтитул3.1, 

виноска, 

заголовок1.1 

35 Побутовий довідник 7090/16 2 4 

колонтитул3.2, 

заголовок1.2, 

декоративні 

елементи 

36 Науково-виробничий довідник 7590/16 1 5 

колонтитул3.2, 

таблиця, 

примітка у тексті 
1.1 — заголовок простий; 
1.2 — заголовок ліхтарик (маргіналія); 
1.3 — заголовок кватирка. 
2.1 — буквиця винесена вгору; 
2.2 — буквиця утоплена; 
2.3 — буквиця вільна/висяча. 
3.1 — колонтитул постійний; 
3.2 — колонтитул змінний. 
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Зміст і форма звіту:  

1. Розрахунки розмірів видання після обрізу, сторінки складання та полів, 

відповідно до завдання. 

2. Створений цифровий файл. 

Контрольні запитання усного звіту: 
1. Як створити нумерацію сторінок з певного номера? 

2. Що таке базова лінія і як прив’язати  рядки абзацу до сітки базових ліній? 

3. Як уникнути завислих рядків у виданні? 

4. Оформлення виносок: як змінити відсоток верхнього індексу, відносно основного 

кеглю? 

5. Як створити стиль заголовків/ текстівок? 

6. Редагування трекінгу/інтерліньяжу у тексті? 

7. Встановити заборону друку для зображення? 

8. Визначити гарнітури застосовані в оригінал-макеті? 

Перелік літератури: 
1. ДСТУ 4489:2005. Видання книжкові та журнальні. Вимоги до форматів. ― Вперше 

(зі скасуванням ГОСТ 5773―90) ; чинний від 2006—10—01. 

2. ДСТУ 3018-95. Видання. Поліграфічне виконання. Терміни та визначення. — К: 

Держстандарт України, 1995. — 21 с.  

3. СОУ 18.1-02477019-14:2015. Видання книжкові. Технічні умови. ― На заміну ГСТУ 

29.5―2001; чинний від 2009—11—01. 

4. СОУ 18.1-02477019-11:2014. Видання для дітей. Загальні технічні вимоги. — На 

заміну СОУ 22.2-02477019-11:2008; чинний від 2014—25—06. 

5. ДСанПіН 5.5.6-138–2007. Державні санітарні норми і правила. Гігієнічні вимоги до 

друкованої продукції для дітей. — На заміну ДСанПіН 5.5.6.084—2002; чинний 

від 2007—02—09. 

6. Паркер Р. Как сделать красиво на бумаге, 2-е издание [Текст]  — Пер. с англ. / 

Р. Паркер. — СПб.: Символ-Плюс, 2008. — 384 с.  

7. Джон Пикок. Издательское дело книга от замысла до упаковки шаг за шагом [Текст] / 

Джон Пикок. — М.: Эком, 1998. — 400 с. 

8. Джеймс Феличи. Типографика: шрифт, верстка, дизайн [Текст] / Джеймс Феличи. — 

СПб.: БХВ-Петербург, 2004. — 496 с. 

9. Френк Романо. Современные технологии издательско-полиграфической отрасли [Текст] / 

Френк Романо. — М.: Принт-Медиа центр, 2006. — 456 с. 

10. Буковецкая О. А. Готовим в печать журнал, книгу, визитку [Текст] / О. А. Буковецкая. 

— М.: Изд-во «НТ Пресс», 2005. — 303 с. 
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а 

 
б 

Рис. 14. Приклади заверстування книжкового видання: а — шмуцтитул та початкова 

сторінки; б — типові сторінки 
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ПРАКТИЧНА   РОБОТА   5 

СТВОРЕННЯ ОРИГІНАЛ-МАКЕТУ БУКЛЕТУ  

 

Мета роботи: навчитися створювати оригінал-макет буклету — шість 

сторінок. Провести обробку та форматування тексту, ілюстративного, декора-

тивного матеріалу відповідно до вимог акцидентної верстки у програмі Adobe 

InDesign. 

Завдання роботи: виконати верстку рекламно-інформаційного буклету, 

відповідно до варіанту.  

Теоретичні відомості. Макетування та верстка рекламно-інформаційних 

буклетів передбачає застосування значних об’ємів графічної інформації: 

растрові/векторні зображення, декоративні елементи. Також, до характерних 

особливостей рекламно-інформаційних буклетів можна віднести вид фальцю-

вання та формат. Найбільш вживаними є такі варіанти фальцювання: 2 та 3-х 

згинне фальцювання «гармошкою», комбіноване фальцювання внамотку та 

«гармошкою», 2 та 3-х згинне «віконне» фальцювання, 2 та 3-х згинне 

фальцювання внамотку (див. рис. 15). Використання нестандартного формату 

видання дає можливість привернути увагу споживачів, особливо популярними  

є поперечний, вузький та квадратний формати. Для вертикального формату 

висота блоку після обрізки перевищує його ширину більше ніж на 20 мм 

(210×297 мм). Ширина блоку поперечного формату перевищує його висоту 

більш ніж на 20 мм (250×176 мм). Висота блоку вузького формату, як правило, 

вдвічі більша його ширини (148×297 мм). У блоку квадратного формату різниця 

між шириною та висотою не повинна перевищувати 20 мм (220×223 мм).  

Робота в програмі Adobe InDesign. Для створення нового документу 

обираємо команду Файл→Новый→Документ за необхідності змінити формат 

та орієнтацію, інші налаштування.  

Для того щоб створити розворот встановлюємо Разворот страницы. Для 

створення документу, який починається з розвороту необхідно у поле № первой 

стр. ввести парне число. Для автоматичного створення текстових блоків 

необхідно встановити Основний текстовий фрейм. Вільний простір навколо 

окреслених сторінок є монтажним столом, на якому розміщуються будь-які 

об’єкти які відображаються лише на екрані. 
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При оформленні буклетів необхідно звернути увагу на те, що буклет це 

невеликий рекламний носій, основна його мета — проінформувати коротко, але 

цікаво про продукт/послугу. Тому необхідно подавати інформацію коротко, 

оформлення обирати орієнтуючись на інтереси цільової аудиторії. Наприклад, 

при виборі кольору буклету для жінок рекомендовано червоний, рожевий, 

пастельні відтінки; для молоді — соковиті, яскраві, кислотні; для ділових 

людей — сірий, синій, стриманий. 

На невеликому форматі буклету більш виграшно будуть сприйматися 

декілька «соковитих» зображень, так званих «якорів» для погляду, ніж багато 

різних картинок, що відволікають увагу. 

Гарнітура шрифту має бути максимально читабельною. Бажано на 

використовувати більше 3-х різних гарнітур. Краще застосовувати різні види 

накреслення для виділення та відділення текстової інформації. 
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Рис. 15. Способи фальцювання буклетів: а – симетричне 2-згинне паралельне; б, в – 2- та 3-

згинне фальцювання «гармошкою»; г, д – 2- та 3-згинне фальцювання «внамотку»; е – 

комбіноване фальцювання «внамотку» та «гармошкою»; є, з, ж – 2-, 3-, 4-згинне «віконне» 

фальцювання 
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Для зміни налаштувань документу обираємо 

команду Файл→Параметры документа. 

На робочому столі розміщені основні 

палітри InDesign: палітра Инструменты — 

містить всі необхідні для роботи інструменти 

рисування та редагування; палітра Управление 

— містить можливі налаштування активного 

інструменту, а також палітри Страницы (перемі-

щення між сторінками публікації та управління 

шаблонами, додавання/виключення/ переміщення 

сторінок), палітра Символ — призначена для 

форматування тексту та проведення різноманітних дій над об’єктами: 

масштабування, переміщення, обертання та ін.; палітра Стили — застосовує-

ться для управління стилями в публікації. Інші палітри знаходяться в меню 

Окно. Основні налаштування програми знаходяться в меню Редактирование→ 

Установки. 

  

Для створення нової таблиці необхідно  

в меню Таблица натиснути Создать таблицу 

і ввести необхідні параметри. Робота з основими 

параметрами таблиці, такими як, кількість рядків/ 

стовпчиків, розміри комірок, розташування тексту здійснюється на палітрі 

Таблица (меню Окно). 
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Більш детальні налаштування таблиці/рядків/стовпчиків/обводки та заливки 

знаходяться Таблица→Параметры таблицы. Налаштування оформлення 

інформації в комірках виконується Таблица→Параметры ячейки. 

 
 

Для коректної підготовки цифрового оригінал-макету необхідно виконати 

Файл→Упаковать. При цьому програма верстки здійснює аналіз, перевірку та 

збір використаних шрифтів, зображень у макеті. 

 

Методика виконання роботи. Згідно індивідуального завдання створити 

оригінал-макет рекламно-інформаційного буклету.  

1. Тематику видання, кількість ілюстрацій, вид та кількість додаткових 

елементів оформлення видання студент обирає самостійно. 

2. Обрати формат видання і відповідно формат сторінки складання, 

кількість та розміри шпальт, враховуючи дані табл. 2. 

3. Оригінал-макет обов’язково має містити таблиці, відповідно до табл. 2. 
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Таблиця 2 — Варіанти завдань для виконання практичної роботи 8 

№  Фарбовість 
Вид/кількість таблиць 

(дані комірок) 

Формат/спосіб 

фальцювання 

1 4+4 повздовжні/3 (текстові) 
вертикальний/2-згинне 

«гармошкою» 

2 5+3 поперечні/2 (змішані) 
поперечний/2-згинне 

«віконне» 

3 4+2 повздовжні клаптикові/5 (цифрові) 
вертикальний/3-згинне 

внамотку 

4 6+4 повздовжні розпашні/3 (текстові) 
квадратний/2-згинне 

«гармошкою» 

5 4+4 поперечні розпашні/2 (змішані) 
вузький/3-х згинне 

«гармошкою» 

6 5+4 повздовжні клаптикові/4 (текстові) 
поперечний/2-згинне 

внамотку 

7 2+2 повздовжні клаптикові/5 (цифрові) 
квадратний/3-згинне 

внамотку 

8 3+2 повздовжні/6 (текстові) 
квадратний/3-х згинне 

«віконне» 

9 4+3 поперечні/5 (змішані) 
вертикальний/4-згинне 

«віконне» 

10 5+5 повздовжні/5 (цифрові) 
поперечний/2-згинне 

«гармошкою» 

11 4+2 повздовжні/2 (змішані) 
вузький/3-згинне 

внамотку 

12 3+3 повздовжні клаптикові/6 (цифрові) 
квадратний/2-згинне 

«гармошкою» 

13 2+2 поперечні/3 (текстові) 
поперечний/3-згинне 

«гармошкою» 

14 4+4 повздовжні/7 (текстові) 
вузький/ симетричне 2-
згинне паралельне 

15 4+5 поперечні клаптикові/3 (цифрові) 
вертикальний/2-згинне 
внамотку 

16 5+5 повздовжні клаптикові/5 (цифрові) 
квадратний/3-згинне 
внамотку 

17 6+4 повздовжні/2 (цифрові) 
вертикальний/4-згинне 
«віконне» 

18 5+2 повздовжні клаптикові/5 (цифрові) 
поперечний/2-згинне 
«віконне» 

19 4+3 повздовжні розпашні/4 (змішані) 
вертикальний/2-згинне 
«гармошкою» 

20 2+2 повздовжні клаптикові/7 (змішані) 
квадратний/3-згинне 
«віконна» 

21 3+3 поперечні клаптикові/4 (цифрові) 
вузький/3-згинне 
«гармошкою» 

22 2+2 повздовжні/3 (цифрові) 
вузький/2-згинне 
«віконне» 

23 5+5 поперечні клаптикові/5 (змішані) 
вертикальний/2-згинне 
внамотку 
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Закінчення табл. 2 

№ Фарбовість 
Вид/кількість таблиць 

(дані комірок) 
Формат/спосіб 
фальцювання 

20 2+2 повздовжні клаптикові/7 (змішані) 
квадратний/3-згинне 
«віконна» 

21 3+3 поперечні клаптикові/4 (цифрові) 
вузький/3-згинне 
«гармошкою» 

22 2+2 повздовжні/3 (цифрові) 
вузький/2-згинне 
«віконне» 

23 5+5 поперечні клаптикові/5 (змішані) 
вертикальний/2-згинне 
внамотку 

24 4+5 повздовжні/4 (текстові) 
квадратний/4-згинне 
«віконне» 

25 5+4 повздовжні розпашні/2 (змішані) 
вертикальний/3-згинне 
«гармошкою» 

26 4+4 повздовжні клаптикові/6 (змішані) 
поперечний/2-згинне 
«гармошкою» 

27 4+3 поперечні/4 (цифрові) 
вертикальний/2-згинне 
внамотку 

28 4+2 повздовжні клаптикові/8 (текстові) 
квадратний/3-згинне 
«гармошкою» 

29 3+3 повздовжні розпашні/3 (текстові) 
вертикальний/3-згинне 
«віконне» 

30 5+5 поперечні/4 (змішані) 
поперечний/3-згинне 
«віконна» 

31 4+5 повздовжні клаптикові/6 (текстові) 
вузький/3-згинне 
внамотку 

32 6+2 повздовжні/2 (цифрові) 
вузький/2-згинне 
«гармошкою» 

33 4+4 повздовжні/6 (змішані) 
вертикальний/2-згинне 
«гармошкою» 

34 5+5 поперечні розпашні/6 (текстові) 
вузький/2-згинне 
«віконна» 

35 3+3 повздовжні клаптикові/4 (змішані) 
вертикальний/3-згинне 
внамотку 

36 2+2 поперечні клаптикові/5 (цифрові) 
квадратний/2-згинне 
«гармошкою» 

Зміст і форма звіту:  

1. Створений цифровий файл. 

2  Звіт з розрахунками формату видання, сторінки складання, кількості та 

розмірів шпальт. 

Контрольні запитання усного звіту: 

1. Як провести колірну корекцію у програмі верстки? 

2. Як визначити застосовані у верстці фільтри до зображень? 

3. Виконати редагування формату видання? 

4. Як здійснити переміщення сторінок у макеті? 

5. Як правильно зберегти файл верстки? 

6. Як перевірити відсутність/модифікацію зображення у макеті? 
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Рис. 16. Приклад виконання роботи: а — лице буклету, б — зворот буклету 
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ПРАКТИЧНА   РОБОТА   6 

СТВОРЕННЯ ЦИФРОВОГО ОРИГІНАЛ-МАКЕТУ 

ЖУРНАЛЬНОГО ВИДАННЯ 

 

Мета роботи: навчитися створювати оригінал-макет журнального видання. 

Провести обробку та форматування тексту, графічного, табличного матеріалу 

відповідно до вимог журнальної верстки у програмі Adobe InDesign. 

Завдання роботи: відповідно до варіанту виконати верстку журнального 

видання. 

Теоретичні відомості. Відмінність журнальної верстки від книжкової 

полягає у більш вільному стильовому оформленні видань. Але при виборі 

формату необхідно дотримуватися рекомендованих розмірів, які наведені  

у «ГСТУ 29.1–97. Журнали. Поліграфічне виконання. Загальні технічні 

вимоги». Часто ширина сторінки складання у журналі розбивається на декілька 

шпальт (колонок).  

Існують свої особливості в оформленні обкладинки для журналів. Як 

правило, обкладинка повинна мати впізнаваний (характерний) вигляд журналу, 

часто домінує шрифтовий логотип, який компонують з вихідними даними 

(номер, дата випуску, індекс видання). Крім того, шрифтове та ілюстративне 

оформлення обкладинки мають розкривати тематичне спрямування журналу. 

Часто на першу сторінку обкладинки виносять назви ключових статей із 

зазначенням номерів сторінок, обов’язково має бути логотип та відомості про 

рік/місяць/номер (таблиця 3). При оформленні змісту журнальних видань також 

прослідковується відмінність від книжкових, як правило, зміст може 

оформлюватися тематичними фото та анотаціями до статей (таблиця 4). 

Початкова сторінка статті має, так званий, заголовний комплекс, який може 

включати назву матеріалу, інформацію про авторів/художників/фотографів/ 

журналістів, коротку анотацію або епіграф, тематичне фото, яке сприяє більш 

глибшому розумінню матеріалу, або може бути фото автора/особи про яку 

йдеться у матеріалі (таблиця 5).  

Для привернення уваги читача застосовують різні прийоми виділення 

інформації: шрифтові, графічні, колірні. 
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Таблиця 3 — Приклади оформлення першої сторінки обкладинки журналів 
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Закінчення табл. 3 
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Таблиця 4 — Приклади заверстування змісту в журналі 
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Таблиця 5 — Приклади заверстування початкової (ліва)  

та типової (права) сторінок журналу 
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Продовження табл. 5 
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Закінчення табл. 5 

 
 

Таблиця 6 — Приклади заверстування кінцевої сторінки, з використанням 

символу, який стилізований під першу літеру назви журналу 

 

 

Назва журналу — стилізована шрифтова шапка 
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Закінчення табл. 6 

  

  

Символ закінчення статі, стилізований під першу літеру назви журналу 

 

Зміст формується на основі попередньо розроблених стилів оформлення 

заголовків. Adobe InDesign працює з текстовими, об’єктними і табличними 

стилями: ОкноСтили. 

 
 

Текстові стилі є двох видів:  

– Стили абзаца –– основний стиль редагування тексту, містить всі 

параметри. Використовується для глобального форматування. 

– Стили символа –– допоміжний стиль, який застосовується до невеликих 

фрагментів тексту (буквиця, терміни тощо), містить тільки параметри формату-

вання символів. Використовується для локальних змін в оформленні символів 

тексту. 
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Загальний алгоритм роботи з різними стилями практично однаковий: 

1. Створити стиль.  

2. Застосувати стиль. 

3. Відредагувати стиль за необхідності.  

Створені стилі застосовуються до кожного рівня заголовків, після чого 

відбувається автоматичне формування змісту: МакетОглавление. 
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Додаткове оформлення змісту (вид заповнення проміжків між текстом  

і нумерацією сторінок, тип вирівнювання, вибір ширини) здійснюється на 

палітрі Табуляторы меню Текст. 

Приведення рядків основного тексту з лиця та зі звороту сторінки 

забезпечується шляхом налаштування параметрів сітки базових ліній, і може 

задаватися для всього документу через меню Редактирование Установки 

Сетки або для конкретного текстового фрейму (блок має бути виділеним) через 

Параметры текстового фрейму. 

 

 
 

Контроль за висячими рядками встановлюється на палітрі Абзац 

Параметры удержания: 

 
 

Налаштування параметрів підпису під рисунками виконується через меню 

Объект ПодписиНастройка подписи. 

Значення має відповідати розміру інтерліньяжу 
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Для формування виноски необхідно після слова поставити курсор і зайти 

в меню ТекстВставить сноску. Налаштування параметрів виноски 

виконується ТекстПараметры сносок. 

 
 

Методика виконання роботи. За даними варіанту (табл. 7) студент 

створює цифровий оригінал-макет журнального видання засобами програми 

Adobe InDesign. Оригінал-макет повинен містити першу та останню сторінку 

обкладинки; композиційно оформлений зміст; початкову, кінцеву та типову 

сторінки складання журналу. Загалом макет має містити не менше 16 сторінок. 

1. Розрахувати розмір видання після обрізу, визначити розміри сторінки 

складання та полів, ширину шпальт та середника, відповідно до завдання. 

2. Для кожного виду сторінки розробити шаблон, за яким потім виконати 

верстку відповідно до правил заверстування конкретного виду журнального 

видання. 

3. Обов’язково створити заголовки трьох рівнів та на їх основі сформувати 

зміст. 
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4. Обов’язково застосувати маркований список та прийоми виділення 

текстової інформації, наприклад, врізки або втяжки. 

5. До кожної ілюстрації заверстати текстівку. 

6. Кількість ілюстрацій, вид та кількість додаткових елементів оформлення 

видання студент обирає самостійно відповідно до тематики журналу. 

7. Звіт виконаної роботи має містити папки з використаними зображен-

нями та шрифтами, файл *.indd виконаної роботи та файл *.pdf для 

попереднього перегляду роботи. 

Таблиця 7 — Варіанти завдань для виконання практичної роботи 6 

№  Вид журналу Формат 

Варіант 

оформ-

лення 

Кількість 

шпальт 

Тип верстки 

ілюстрацій 

1 Громадсько-політичний 70108/8 2 3 
відкрита, 

закрита 

2 
Науковий з незначною 

кількістю ілюстрацій 
6090/16 2 2 

в оборку,  

відкрита 

3 Науково-популярний для 

широкого кола читачів 
6084/8 1 2 

в оборку,  

відкрита,  

з виходом на 

поле  

4 Виробничо-практичний 

ілюстрований 
70108/16 2 3 

врозріз, 

закрита 

5 
Популярний для широкого 

кола читачів 
84108/16 1 2 

фонова,  

на полях, 

 в оборку 

6 
Літературно-художній для 

дітей старшого шкільного 

віку 

70100/16 1 2 

відкрита,  

в оборку, 

закрита, 

фонова 

7 Реферативний 6084/8 1 2 
відкрита, 

врозріз 

8 
Виробничо-практичний з 

незначною кількістю 

ілюстрацій 

6084/16 1 1 

в оборку, 

закрита, 

врозріз  
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 Продовження табл. 7 

№  Вид журналу Формат 

Варіант 

оформ-

лення 

Кількість 

шпальт 

Тип верстки 

ілюстрацій 

9 Науковий ілюстрований 6084/8 1 3 

закрита,  

в оборку,  

на полях 

10 Науково-популярний для 

середнього шкільного віку 
6090/8 2 3 

закрита з 

виходом на 

поле, глуха 

11 Літературно-художній для 

молодшого шкільного віку 
84108/32 2 1 

відкрита 

розпашна,  

в оборку  

12 Громадсько-політичний 70108/16 1 3 

відкрита, 

закрита, 

глуха по 

контуру 

13 Науково-популярний для 

старшого шкільного віку 
70100/16 2 2 

в оборку, 

відкрита, 

врозріз 

14 
Виробничо-практичний  

з незначною кількістю 

ілюстрацій 

6090/8 1 3 

відкрита, 

закрита, 

глуха по 

контуру 

15 
Популярний для широкого 

кола читачів 
84108/32 1 3 

врозріз,  

в оборку, 

відкрита під 

обріз 

16 Виробничо-практичний 

ілюстрований 
84108/16 2 2 

в оборку, 

відкрита, 

закрита, 

фонова 

17 Громадсько-політичний 70100/16 1 2 

відкрита, 

глуха, на 

полях 

18 Науково-популярний для 

середнього шкільного віку 
70100/16 2 3 

закрита, 

відкрита, 

фонова, 

розпашна 
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Продовження табл. 7 

№  Вид журналу Формат 

Варіант 

оформ-

лення 

Кількість 

шпальт 

Тип верстки 

ілюстрацій 

19 
Науковий з незначною 

кількістю ілюстрацій 
70108/16 2 2 

відкрита,  

в оборку  

20 Науково-популярний для 

широкого кола читачів 
84108/16 1 2 

відкрита, 

врозріз,  

в оборку 

21 Виробничо-практичний 

ілюстрований 
6084/16 2 3 

відкрита з ви-

ходом на поле 

під обріз, 

врозріз 

22 
Популярний для широкого кола 

читачів 
70100/16 1 2 

відкрита, 

закрита, 

фонова,  

в оборку по 

контуру 

23 Літературно-художній для дітей 

старшого шкільного віку 
84108/16 1 2 

відкрита,  

на полях 

24 Реферативний 6090/8 1 2 
закрита, 

відкрита 

25 
Виробничо-практичний з 

незначною кількістю 

ілюстрацій 

70108/16 1 1 
врозріз, 

відкрита 

26 Науковий ілюстрований 84108/16 1 3 
закрита, 

врозріз,  

27 
Науково-популярний для 

дорослих 
6090/8 2 3 

глуха, в оборку 

по контуру, 

відкрита  

під обріз 

28 Літературно-художній для 

молодшого шкільного віку 
70108/16 2 1 

фонова, 

відкрита 

29 Громадсько-політичний 70108/8 1 3 
на полях, 

закрита 

30 Науково-популярний для 

старшого шкільного віку 
6090/8 2 2 

закрита,  

на полях, 

відкрита 

розпашна 

31 
Виробничо-практичний  

з незначною кількістю 

ілюстрацій 

6084/8 1 3 
закрита, 

глуха, врозріз 
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Закінчення табл. 7 

№  Вид журналу Формат 

Варіант 

оформ-

лення 

Кількість 

шпальт 

Тип верстки 

ілюстрацій 

32 
Популярний для широкого кола 

читачів 
70108/16 1 3 

фонова, на 

полях, в 

оборку 

33 Виробничо-практичний 

ілюстрований 
84108/16 2 2 

відкрита, 

закрита 

34 Громадсько-політичний 70108/8 1 2 
врозріз,  

в оборку 

35 
Літературно-художній для 

дошкільнят 
6090/8 1 1 

на полях,  

в оборку 

36 Науково-популярний для 

широкого кола читачів 
84108/32 1 1 

фонова, 

відкрита 

Зміст і форма звіту:  

1. Розрахунки розмірів видання після обрізу, сторінки складання та полів, 

ширини шпальт та середника, відповідно до завдання.  

2. Створений цифровий файл. 

Контрольні запитання усного звіту: 
1. Як створити зв’язані текстові блоки? 

2. Як призначити стиль абзацу/символу до тексту? 

3. Як створити зміст/список ілюстрацій? 

4. Як перемістити сторінки у публікації між собою? 

Перелік літератури: 
1. Паркер Р. Как сделать красиво на бумаге, 2-е издание  — Пер. с англ. / Р. Паркер. — 

СПб.: Символ-Плюс, 2008. — 384 с.   

2. Комолова Н. В. Компьютерная верстка и дизайн [Текст] / Н. В. Комолова. — СПб.: 

БХВ-Петербург, 2003. — 512 с. 

3. СОУ 18.1-02477019-06:2015. Журнали. Технічні умови (зі зміною № 1). ― На заміну 

ГСТУ 29.1―97; чинний від 2007—02—01.  
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ПРАКТИЧНА   РОБОТА   7 

СТВОРЕННЯ ОРИГІНАЛ-МАКЕТА ГАЗЕТИ  

 

Мета роботи: навчитися створювати оригінал-макет газети — одна 

сторінка складання, виконувати обробку та форматування тексту, ілюстра-

тивного матеріалу відповідно до вимог газетної верстки у програмі Adobe 

InDesign. 

Завдання роботи: виконати верстку газети, відповідно до варіанту.  

Теоретичні відомості. При верстці газет застосовуються засоби 

відокремлення інформації: рамки, лінійки, кінцівки, проміжки та різні 

декоративні елементи (зірочки, ромби, тощо). Вони розділяють текстову та 

графічну інформацію, а також дозволяють виділити найважливіші з них. 

В газеті використовують лінійки різних типів. Для розділення текстових 

шпальт на сторінці складання використовують шестипунктові (близько 2,25 

мм) прямі міжшпальтові лінійки. Часто лінійки заміняють проміжками 8–12 п. 

(3–4,5 мм), що дозволяє розвантажити сторінку складання. У випадку вузьких 

текстових шпальт бажано застосовувати міжшпальтові лінійки, що попереджує 

злиття сусідніх рядків тексту. 

Для відокремлення сусідніх добірок однієї сторінки складання використо-

вують різні лінійки: прямі подвійні тонкі, рантові, хвилясті, асюре. У малофор-

матній газеті кегль лінійок 2, 4, 6, 8 п (приблизно 0,75; 1,5; 2,25; 3 мм),  

у великоформатній кегль можливо збільшити до 16 п і більше. 

Для розділення тексту по вертикалі, виділення заголовків/підзаголовків, 

авторських підписів також часто застосовують декоративні елементи (ромби, 

зірочки, крапки та інші фігурні елементи різних форм та розмірів). Також 

декоративні елементи використовують для оформлення закінчення статті. 

Методика виконання роботи. Згідно індивідуального завдання створити 

оригінал-макет газети засобами програми Adobe InDesign. 

1. Розробити шаблон для титульної сторінки газети та виконати її верстку, 

дотримуючись шаблону. 

2. Розробити шаблонні сторінки щонайменше трьох рубрик та виконати їх 

верстку відповідно до шаблону. 

3. При виборі шрифтового та графічного стилю для оформлення газети 

необхідно враховувати дані таблиці 8. 
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Таблиця 8 — Варіанти завдань для виконання практичної роботи 7 

1 Розважальна дитяча газета 

2 Газета наукового спрямування 

3 Пізнавальна дитяча газета 

4 Розважальна газета для широкого кола читачів 

5 Щоденна газета новин 

6 Студентська газета 

7 Щомісячна газета. Тематика: рукоділля 

8 Розважальна газета для дітей молодшого шкільного віку 

9 Щотижнева газета спортивного спрямування 

10 Щомісячна газета. Тематика: здоров’я 

11 Щомісячна районна газета. Тематика: новини району 

12 Щоденна газета новин 

13 Газета наукового спрямування 

14 Пізнавально-розважальна дитяча газета 

15 Розважальна газета для широкого кола читачів 

16 Щоденна газета новин 

17 Студентська газета 

18 Щомісячна газета. Тематика: освіта 

19 Спеціалізована професійна щоквартальна газета. Тематика: поліграфія 

20 Щоденна громадсько-політична газета 

21 Щомісячна газета. Тематика: сільське господарство 

22 Щомісячна газета. Тематика мистецтво 

23 Розважальна дитяча газета 

24 Щомісячна газета. Тематика здоров’я 

25 Громадсько-політична газета «Влада та гроші» 

26 Щомісячна районна газета 
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Зміст і форма звіту:  

1. Створений цифровий файл. 

Контрольні запитання усного звіту: 
1. Вирівнювання об’єктів між собою та відносно сторінки складання? 

2. Як створити текст вивороткою? 

3. Як створити кутову напіввідкриту рантову рамку? 

4. Як розбити текстовий блок на шпальти та редагувати ширину середника між 

шпальтами? 

5. Як створити оригінальний маркер для списків/переліків? 

Перелік літератури: 
1. СОУ 18.1-02477019-03:2015. Газети. Технічні умови (зі зміною № 1). ― На заміну 

ГСТУ 29.3―2000; чинний від 2006—01—01. 

2. Іванов В. Ф. Техніка оформлення газети: Курс лекцій [Текст] / В. Ф.Іванов. – К.: Т-во 

«Знання», 2000. – 222 с. 

3. Галкин С. И. Техника и технология СМИ: Художественное конструирование газеты 

и журнала: Учеб. пособие [Текст] / С. И. Галкин. — М.: Аспект Пресс, 2005. — 215 с. 

 

  

  

Рис. 17. Приклад виконання практичної роботи 7 
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ПРАКТИЧНА   РОБОТА   8 

СТВОРЕННЯ ІНТЕРАКТИВНОГО ОРИГІНАЛ-МАКЕТУ  

ВИРОБНИЧО-ПРАКТИЧНОГО/ДОВІДКОВОГО 

АБО РЕКЛАМНОГО ВИДАННЯ 

 

Мета роботи: створити оригінал-макет оформлення виробничо-

практичного/довідкового або рекламного видання з інтерактивними елементами. 

Провести обробку та форматування тексту, ілюстративного, декоративного 

матеріалу у програмі Adobe InDesign, відповідно до вимог верстки. 

Завдання роботи: виконати верстку видання, відповідно до варіанту. 

Теоретичні відомості. Інтерактивний документ — це файл, призначений 

не для друку, а для перегляду на екрані електронного пристрою. В Adobe 

InDesign є можливість створювати інтерактивні публікації двох видів для 

експорту в інтерактивний PDF та Adobe Flash.  

Для створення нового інтерактивного документу необхідно визначити 

розміри документу, може бути два варіанти: створення для інтернету або для 

мобільного пристрою. Меню ФайлНовыйДокументДля Интернета/ 

Мобильное устройство (рис. 18–19). 

 

Рис. 18. Створення документу для інтернету 
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Рис. 19. Створення документу для мобільних пристроїв 

Для створення у змісті переходів (гіперпосилань) на сторінки макету 

необхідно, у сформованому змісті, призначити сторінкам гіперпосилання на 

відповідну сторінку у меню Текст Гиперссылки и перекрестные ссылки 

Новая гиперссылка.  

 

При створенні інтерактивної версії pdf-файлу часто використовують 

Закладки, такий прийом сприяє зручній навігації по сторінкам макету. 

Створення закладок у макеті виконується на палітрі Закладки меню 

ОкноИнтерактивные элементыЗакладки. Закладки можуть виступати 

посиланнями на початок цілого розділу або підрозділу, а також на внутрішні 

підрозділи або абзаци.  
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Панель Закладки Adobe Acrobat Pro Палітра Закладки Adobe InDesign 

 

Методика виконання роботи. Згідно індивідуального завдання створити 

оригінал-макет виробничо-практичного/довідкового або рекламного видання 

засобами програми Adobe InDesign.  

1. Вид та кількість додаткових елементів оформлення видання студент 

обирає самостійно, враховуючи дані таблиці 9. 

2. Обов’язкові додаткові елементи, які необхідно використати: колонтитули, 

колонцифри, плашки, лінійки, таблиці, списки, схеми (графічні зображення, 

ілюстрації, які за допомогою умовних графічних позначень передають зміст 

побудови предмета або системи, показує характер процесу, рухи, структуру 

тощо). 

3. У макеті необхідно реалізувати зручну навігацію по сторінках макету на 

основі гіперпосилань та закладок.  

4. Реалізувати посилання на зовнішні джерела інформації.  

Таблиця 9 — Варіанти завдань для виконання практичної роботи 8 

№ 

п/п 
Вид видання 

1.  Посібник користувача «Цифрова фотокамера»  

2.  Каталог змішувачів для ванної кімнати  

3.  Інструкція з використання «Розвиваючий дитячий ноутбук»  

4.  Інструкція з використання «Побутова техніка»  

5.  Каталог аксесуарів до відеокамери з технічними характеристиками  

6.  Посібник користувача «Вимірювальний прилад»  

7.  Каталог технічних характеристик газонокосарок  

8.  Каталог «Настільні видавничі системи»  

9.  Інструкція користувача «Дитячий металевий конструктор»  

10.  Інструкція з використання кондиціонеру  

11.  Каталог аксесуарів для ванної кімнати  

12.  Гарантійний талон побутової техніки  

13.  Інструкція з використання косметичних засобів  
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Закінчення таблиці 9 

№ 

п/п 
Вид видання 

14.  Каталог технічних характеристик принтерів  

15.  Інформаційний каталог поліграфічних матеріалів  

16.  Інструкція користувача «Електронний конструктор»  

17.  Інструкція з використання офсетних пластин  

18.  Каталог технічних характеристик автомобілів  

19  Інформаційний каталог офсетних полотнищ з технічними характеристиками  

20.  Каталог технічних характеристик CTP-пристроїв  

21. Рекламний інформаційний каталог корму для тварин 

22. Рекламний каталог канцелярських товарів 

23. Каталог рекламних сувенірів від компанії «Придумати назву» 

24. Рекламний каталог аксесуарів для кухні 

25. Інструкція користувача «Дитячий конструктор» 

26. Рекламний каталог текстильних сумок 

Зміст і форма звіту: 

1. Створений цифровий файл. 

Контрольні запитання усного звіту: 
1. Як налаштувати посилання на сторінку, зовнішнє джерело? 

2. Які структурні елементи макету сприяють зручній навігації? 

3. Як створити закладки у макеті? 

4. Як необхідно зберегти файл для підтримки інтерактивності елементів? 

Перелік літератури: 
1. Паркер Р. Как сделать красиво на бумаге, 2-е издание — Пер. с англ. / Р. Паркер. — 

СПб.: Символ-Плюс, 2008. — 384 с. 

2. Джон Пикок. Издательское дело книга от замысла до упаковки шаг за шагом [Текст] 

/ Джон Пикок. — М.: Эком, 1998. — 400 с. 
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ПРАКТИЧНА РОБОТА 9 

СТВОРЕННЯ ОРИГІНАЛ-МАКЕТУ  

ВИРОБНИЧО-ПРАКТИЧНОГО/ДОВІДКОВОГО 

АБО РЕКЛАМНОГО ВИДАННЯ З МУЛЬТИМЕДІЙНИМИ 

ЕЛЕМЕНТАМИ 

Мета роботи: створити оригінал-макет оформлення виробничо-практичного/ 

довідкового або рекламного видання з використанням анімаційних ефектів та 

мультимедійних елементів.  

Завдання роботи: застосувати для оформлення макета анімаційні ефекти 

та мультимедійні елементи; за основу взяти створений інтерактивний макет  

у практичній роботі 8. 

Теоретичні відомості. Анімаційні ефекти додаються до текстових або 

графічних об’єктів на палітрі Анимация меню ОкноИнтерактивные элементы. 

Мультимедійні елементи (відео-, аудіофайли) додаються або через Файл 

Поместить або на палітрі Мультимедиа меню ОкноИнтерактивные элементы, 

на цій палітрі же налаштовуються параметри відтворення файлів. 

 

  

Для експорту мультимедійного файлу використовується формат swf: 

ФайлЭкспортFlash Player (SWF).  
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Методика виконання роботи. Відповідно до індивідуального завдання, 

яке необхідно було виконати у практичній роботі 8 створити оригінал-макет 

з використанням анімаційних ефектів та мультимедійних елементів. Макет має 

містити щонайменше чотири повністю оформлені сторінки, невраховуючі 

початкової. 

1. Застосувати переходи до сторінок у файлі. 

2. Застосувати ефекти анімації до текстових та графічних блоків. 

3. Розмістити відео- та аудіо- інформацію у макеті. 

4. Зберегти файл у форматі *.indd, виконавши зборку, та експортувати у 

формат *.swf. 

Зміст і форма звіту: 

1. Створений цифровий файл. 

Контрольні запитання усного звіту: 
1. Як налаштувати посилання на сторінку, зовнішнє джерело? 

2. Які створити та налаштувати анімацію для тексту, графічних зображень? 

3. Як розмітити мультимедійні файли у макеті? 

4. Як зберегти файл з підтримкою мультимедійних елементів? 

Перелік літератури: 
1. Паркер Р. Как сделать красиво на бумаге, 2-е издание — Пер. с англ. / Р. Паркер. — 

СПб.: Символ-Плюс, 2008. — 384 с. 

2. Джон Пикок. Издательское дело книга от замысла до упаковки шаг за шагом [Текст] 

/ Джон Пикок. — М.: Эком, 1998. — 400 с. 
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